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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for
5.0.35.2 Additional Content Pack(s)

Step 1: Run Content Installer for Additional Content
Pack(s)

1. If you have not done so already, download any additional content pack installer
(s) from the customer portal, http://biznet.flexnetoperations.com

2. Extract the contents of the .zip to any location that is accessible from both the
server and the client workstations.

3. Browse to the extract directory and double-click on the file named setup.exe.

I} cP BizContent ..o -0l x|
‘Q\ ;‘?| P el iE s S IR * &Y | search CP BizContent 34... \Q‘
Organize =  Indudeinlibrary ~  Sharewith ~  Mew folder - O @

e
\'7 Favorites ﬁBizInsight Content Installer.msi
Pl Desktop EHpighlst.Content Specs - | 1. x5
4. Downloads 1 )Setup.exe
2| Recent Places
- Libraries
| Documents ;I

l 3 items

4. The Welcome dialog will open. Click Next.
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for

5.0.35.2

Additional Content Pack(s)

=10l ]

v Welcome to the BizInsight Content

Installer  Content Pack Name Setup
Wizard

The Setup Wizard will install BizInsight Content Installer
BizInsightSunGardEAS on vour computar, Click Mext ko
continue or Cancel bo exik the Setup Wizard,

Back: Cancel |

5. Review the End User License Agreement and if you agree to the terms, check the |

accept the terms in the License Agreement checkbox and click Next.

i@ > sm =lnix|
' End-User License Agreement

Please read the following license agreement carefully
#29BizNetsoftware’

4

End User License Agreement

NOTICE TO ALL USERS: PLEASE READ THIS AGREEMENT
CAREFULLY. BY CLICKING THE ‘T AGREE™ BUTTON AT
THE BOTTOM OF THIS PAGE OR BY INSTALLING AND
USING THE SOFTWARE. YOU AGREE TO ACCEPT ALL OF
THE TERMS AND CONDITIONS OF THIS AGREEMENT
AND YOU AGREE THAT THIS AGREEMENT IS

TATCAOADCTADIT AC TC TT ITATY DOTAT CTANTTY DV WATT 'I'ELI

[V 1accept the terms in the License Agreement

Print Badk I MNext I Cancel
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for

5.0.35.2

Additional Content Pack(s)

6. Click on the desired Setup Type button.

i‘é’- BizInsight Content Installer SaSssias Setup ) =10lxl

Choose Setup Type

Choose the setup type that best suits your needs
#29BizNetsoftware’

Installs the most common program features. Recommended for most users.

Custom |

Allows users to choose which program features will be installed and where
they will be installed. Recommended for advanced users.

Complete |

All program features will be installed. Requires the most disk space.

Badk | et | Cancel

Custom setup type options that are available:

i‘é’- BizInsight Content Installer SaSs S Setup ) - =]

Custom Setup

Select the way you want features to be installed.
#7¢BizNetsoftware’

Click the icons in the tree below to change the way features will be installed.

= L4 | BizInzight
<=3 = | Desktop Shortcut
- (=3 | Program Menu Shortout

This feature requires 327ME on
your hard drive.

4 | |

Location: C:\Program Files (x86)\BizNet Software\BizNetERP B
1.0.0.0Y

Reset Disk Usage Back I Mext I Cancel |

BizNet Software, Inc

3| Page



BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for
5.0.35.2 Additional Content Pack(s)

7. Click Install.

IE(
Ready to install BizInsight Content Installer o
#2¢BizNetsoftware’

Click Install to begin the installation. Click Back to review or change any of your
installation settings. Click Cancel to exit the wizard.

Back I @ Install I Cancel

8. Click Yes to any User Account Control messages.

@ User Account Control [ |

F Do you want to allow the following program from an unknown
./ publisher to make changes to this computer?

Program name: - - -

Publisher: Unknown
File origin: Hard drive on this computer

j Show details Yes | No I

Change when these notifications appear

9. When the installer completes, an icon will exist on the desktop if you did not dis-
able the creation of shortcuts.

o,

BizInsight

- g W aa

10. Double-click the shortcut on the desktop to launch the content installer. If you
chose a Custom installation and disabled the creation of shortcuts, you must
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BizInsight
5.0.35.2

Installing Additional Content Packs: Step 1: Run Content Installer for

Additional Content Pack(s)

browse to the directory to which the content installer files were extracted and
double-click the BizNet Content Installer.exe. If you installed to the default dir-
ectory location, that directory can be found in C:\Program Files (x86)\BizNet Soft-

warekEpicor.

11. The content installer will inspect the server and determine what elements already

exist and indicate their presence with a green check mark.

BizInsight = & Content Installer

Relevant Information

:
" Reporting Server Found

—Manual Install Stages

“ Reporting Server User Found

MI Q Scripts Have Not Been Run
MI Q S 8 DataSet Content Not Found
Run Script Files | g S 8 MetaData Content Not Found

9 S % Function Content Not Found
& Users Have Been Added by Admin Tool

Eelavibta e bR =) ¥ Setiings Need To Be Configured by Config Tool
Deploy MetaData Content |
Deploy Function Content |

Admin Tool |
Config Tool |

e o

|

12. Click on the Relevant Information link in the upper right corner and make a note
of the Report Folder name:

— Manual Install Stages

Install Report 5
Creste Report Sen

Run Script Fil

Deploy DataSet C
Deploy MetaData |

Deploy Function C

Admin Tool

Automatic Insl Relevant Information

Relevant Information

Config Path: A\SERVER2008R2"ConfigurationPath
CABizlnsight Share Config

Admin Path A\SERVER2008R2\Administration Path

C\BizInsight ShareAdmin

Report Server Ur: http //SERVER2008R 2/Report Server

Report Folder BizMetERP

Saql Server MetaData
Database and Instance Name: SERVERZ008R2

Packaged with Content Packager Version 1.4.0.0

Cortfig T
e Copy to Clipboard |

]

=1olx|

e | N

Note |If the Relevant Information dialog does not contain any information and

BizNet Software, Inc
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BizInsight

5.0.35.2

Installing Additional Content Packs: Step 1: Run Content Installer for

Additional Content Pack(s)

13.

14.

BizInsight is already installed, go to a workstation where Bizinsight is installed.
Open Excel on the workstation, click on the Application Settings button on the
Bizlnsight ribbon and copy the values provided for the Configuration Path, the
Administration Path, the Default Reporting Services Server and the Default

Reporting Services Folder Name fields.

Click Automatic Install.

BizInsight &% - Content Installer 5[
Relevant Information
‘ Automatic Install ' .
'/ Reporting Server Found
—Manual nstall Stages

'/ Reporting Server User Found

m' Q Scripts Have Not Been Run
Create Report Server User 0 S8 DataSet Content Not Found
Run Script Files 0 S MetaData Content Not Found

m S8 Function Content Not Found
"/ Users Have Been Added by Admin Tool

e mbesr e W/ Settings Need To Be Configured by Config Tool
Deploy MetaData Contert
Deploy Function Content

Admin Tool
Corfig Tool

e R

The content installer will deploy the MetaData and function

content. The path

will be automatically defaulted to the path last used. Click OK.

— Deploy Local Contert
Please choose a directary location for the Corfiguration Path: IC: \Bizlnsight Share\Corfig

This directory wil become 2 shared network directory afterthe installation procsss.

I™ Ovenide Configuration Path

[~ For Technical Use Only

Currerily instaling to Sal Serverinstance: Not Selected Yet

™ Ovemide Automatic Sql Server Detection

Select A Sql Server For MetaData: Select Sgl Server,

Ok Cancel

’—nepuy Local Cortent

Please choose a drectory location for the Corfiguration Path: [ Fizhsiht 5hare Config

This drectory will become  shared network drectory after the installation process.

™ Ovenmide Corfiguration Path

Ok Cancel

Pre Installation Question

Please choose a directory location forthe Corfiguration Path: IC \¥LConnectShare\Config

Deploy Local Cortent
( This directery will become @ shared netwerk diectory after the installation process.

™ Ovenide Corfiguration Path

Ok Cancel

4

NOTE | Do not check the Override Automatic SQL Server Detection checkbox to
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for
5.0.35.2 Additional Content Pack(s)

ensure the meta data is installed to the same meta data databases as your other
content.

15. The content installer will open the content deployment dialog. Most paths will
not need to be changed. But you must check the following to make sure they are
correct:

a. Make sure the folder name is the folder name currently being used. If the
folder is not the same as shown in the Relevant Information dialog,
change that field to match the folder that is currently being used.

_ioix
I ol
[C-Program Fie (B8 BaNet Saftn Cortig Path: \\SERVER2008R2\ConfiqurationPath
Directory whers you instalied the content{ C:\BizInsight Share'\Conig
| Changethe folder nameif \\SERVER2008R2\AdministrationPath
—Reporting Services Settings — it does not match the C:\Bizlnsight Share’\Admin

information from the
e T2 Relevant Information hitp-//SERVER2008R2/Report Server
R2/Repd dialog

Formeat: "http://server/rapartserver B

Default Reporting S
Tt /-

BizNetERP

Default Reporting Services Foldas

ql Server MetaData
Database and Instance Name: SERVER2008R2
Full name of the foider on the reporting sa1
Copy to Clipboard

Deploymert Options .
’7 | Data Source Name: |

b. Adjust the Server Name field if your accounting system database is on
another server. NOTE |The server name will default to the last server used.
This may not be the right server for the content pack being deployed.

c. Adjust the Database Name field to point to your accounting system data-
base. If your accounting software uses a system or control database,
provide the name of that database rather than a company database name.
NOTE|The database name will default to the last database used. This may
not be the right database for the content pack being deployed.

16. Select the desired authentication method - Windows authentication or Prompt
for Credentials.

| IMPORTANT |You must use the same authentication method as selected for
other content packs.
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for

5.0.35.2 Additional Content Pack(s)
— Deployment Options —— — Datasource Configuration
Data Source MName:
™ Ovenwrite Datasounces IHSGF‘
Server Name:
¥ Overwite Reports [SERVER2003

Database Mame:
ID:,'namic:s
™ Use Folders for Datasources (r& Lze Windows Authentication ]

- T X
I B e B el e
ESENVE. FOIQET STUCIUNE

]
-

" Prompt For Credentials

-

Deploy Contert | Exit |
Ve

17. Click Deploy Content.

18. The content installer will display a status message to indicate that it is working.

Working, Please Be Patient

Y

19. Once complete, the installer will display links to the Reporting Services sites.
Click OK to continue with the installation.

BizNet Software, Inc 8| Page



BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for
5.0.35.2 Additional Content Pack(s)

20. The License Administration Tool will open. Unless you need to add new users,
click Exit.

License Administration Tool - SERVER2008R2\linda =10 x|

Administration Path

| ]

MNetwark share where your license file is stored.

Validate License |

.g F
o

21. The content installer window will display the results of the automatic install.
Click Close.
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BizInsight Installing Additional Content Packs: Step 1: Run Content Installer for

5.0.35.2

Additional Content Pack(s)

22. Click Exit to close the content installer.

X

BizInsight v Content Installer
Relevant Information
| Automatic Install I

— Manual Install Stages
Install Report Server |

Create Report Server User |

Run Script Fies |

Deploy DataSet Cortert |

Deploy MetaData Contert |

Deploy Function Content |

Admin Tool |

Corfig Tool |

(= |

—

' Reporting Server Found

" Reporting Server User Found

' Scripts Have Been Run

S DataSet Content Found

S . MetaData Content Found

&/ 8 Function Content Found

" Users Have Been Added by Admin Tool

¥ Settings Have Been Configured by Config Tool

n

23. Repeat the above steps for each content pack that needs to be installed.
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Installing Additional Content Packs: Step 2: Updating Client

Bizlnsight 5.0.35.2 Workstations

Step 2: Updating Client Workstations

Once all BizContent updates have been updated on the server, each client workstation
installation needs to be updated with the new content add-in files and BizInsight
Desktop Edition installed if the new content pack is a System Connector.

If BizInsight is being used in a Citrix/Terminal Services environment, see "Implementing
Additional BizInsight Content on a Citrix/Terminal Services Server" on page 13.

If BizInsight is installed on individual workstations, instruct all BizInsight users to click
on the Scan for Content button on the BizInsight ribbon in Excel to update their work-
stations with the new content.

Home Insert Page Layout Formulas Data Review View EizInsight

%’9, ﬂﬁléyxg »3S%E?M

Bizlnsight Application Data Expression Offline 5ave Changed Scan for ByPass Show  BizMNet About
Explorer  Settings Caches Editor to BizInsighty Content JCache SCQL  Assistant

BizInsight Reporting and And Yk

If the users report that the Scan for Content button is missing, they may not have the
most current BizInsight version. The Scan for Content button was added in version 5.5
SP1. BizNet Software recommends downloading and installing the latest BizInsight ver-
sion but if you must use an older version, see "Manually Installing BizContent Add-ins"

on page 14.

If your users report an error similar to the following when opening Excel again, see
"Resolving “.xll could not be found” errors" on page 26 for steps to resolve.

Microsoft Office Excel IEI

‘ciluserslinda‘\documents\BizContent\BizNetERP . xII' could not be found. Check the spelling of the file name, and
verify that the file location is correct.

If you are trying to open the file from your list of most recently used files, make sure that the file has not been

renamed, moved, or deleted,
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

Appendices
Implementing Additional Bizinsight Content on a Citrix/Terminal
SEIVICES S@IVEI ... 13
Manually Installing BizContent Add-ins ... 14
Resolving “.xll could not be found” errors ... 26
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

Implementing Additional Bizinsight Content on a Citrix/Terminal Ser-
vices Server

1. Copy all new BizContent add-in files (.dll, .dna and .xll) from the Configuration
Path to the local BizInsight directory. If you do not know the location of the Con-
figuration Path, launch the Content Installer on the server and click on the Rel-
evant Information link in the upper right of the dialog.

2. Browse to the reg5 subdirectory of the local BizInsight directory. Open the file
named "Excelxxxx_register_OnDemand.reg" with Notepad.

3. Copy the last Openn entry in this file and paste directly below. Increment the
Openn and change the name to the new BizContent .xll file name. Repeat for each
new content .xll file until all are represented in the file. For example:

"OPEN"="/A \"BizInsightXL.Foundation\""

4. Save your changes to the file.

5. Browse to the reg5 subdirectory of the Bizlnsight directory and execute the
"Register BizInsight for Excel xxxx OnDemand.bat" file to make sure it runs
without error.

6. Have each BizInsight user execute the "Register BizInsight for Excel xxxx OnDe-
mand.bat" to register the additional content for their login.

BizNet Software, Inc 13| Page



Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

Manually Installing BizContent Add-ins

If you are using a Bizlnsight version that is older than 5.5 SP1, you will need to register
the BizContent add-ins manually in Excel. BizNet Software recommends upgrading to the
latest BizInsight version but if that is not possible, perform the following steps:

1. Browse to the Bizinsight shared directory and copy the content add-in files (.dll,
xll and .dna) to the directory to which you installed the BizInsight client. If you
are using separate config and admin folders, the client add-in files will be in the
config folder.

BizInsight — O] %
[ ]
‘G( :}v| .+ O5(C:) = BizInsight ~ - l‘i]] I Search BizInsight \Ei]‘
Organize *  Includein library =  Sharewith + 3> HE - B:l I@l
. bing
regs

&BizNetERF‘.dll

| 7| BizhetERP. dna

[ BizMetERP, =l

[} ©pen a Suppart [ssue

o items

The remaining steps vary based on the Office version installed:

Office 2010/2013 steps
Excel 2007 steps
Excel 2003 steps

Excel 2010/2013

1. Click on File > Options.
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BizInsight 5.0.35.2 Installing Additional Content Packs: Appendices

E- ri ) - - |
.i. Home Insert
= save

B save As

£ Open

jj Close
Info

Mew

Print

Save & Send

Help

| :] Options L; |
B Exit
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BizInsight 5.0.35.2

Installing Additional Content Packs: Appendices

Click on Add-ins in the left pane and then click on Go at the bottom on the

right pane.

Headers and Footers
Hidden Rows and Columns
Hidden Worksheets
Invisible Content
Microsoft Actions Pane 3
Solver Add-in

Document Related Add-ins

Disabled Application Add-ins

Ada.in: Bizinsight

S\Microsoft Office’\Officel 4.OFFRHD.DLL
E]\Micrasoft Office\Office14\OFFRHD.DLL
AT\Microsoft Office\OMiceld\OFFRHD.OLL
A&f'\Microsoft Office\Officel $\OFFRHD.DLL

e\ Officel 4 Libran\SOLVER\SOLVER.XLAM

Publisher: <Monex
[ Ho available
Location: C\Bizinsight\bin5'adxloader.dil

Deseription:  AddinModule

Document Inspector
Document Inspector
Document Inspector
Document Inspector
XML Expansion Pack
Excel Add-in

21
General "
4 s View and manage Microsoft Office Add-ins.
Formulas
Pracfing Aga-ins
Save Mame - [Locatian [Type [4]
Active Application Add-ins
Language Bizinsight CABizlnsight\binS\aculoader. dll COM Add-in
p— SizinsightXL Faundation CAWindowes\SysWOWE4\mscoree.dil Excel Add.in
o R Inactive Application Add
Analysis ToolPak JieeOMiceld\LibraryAnalysis ANALYSI2.XLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA (Officeld\Libranp\Analysis\ATPVBAEN.ILAM  Excel Add-in
Custom XML Data &l'\Microsoft Office\Officel 00OFFRHD.OLL  Document Inspector
Add-Ins Date (MU Jes\microsoft shared\Smort Tag\MOFLDLL  Action
Eura Currengy Toals A Office\Dfice1 #\Library EUROTOOLNLAM  Excel Add-in
Trust Center Finandial Symbal (ML) Jes\microsoft shared\Smart Tag\MOFLDLL  Action

Manage: [Excel Ad
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

2. In the Add-ins dialog, click on the Browse button.

faadms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

-r-u_.-o.-——
Automation... |

=
—BizInsight¥L .Foundation
ProgID: BizInsightXL.Foundation

3. Browse to the directory to which you installed Bizlnsight and select the .xll
file in that directory. Then click OK.

x|
‘Q\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}
Organize *  MNew folder == o« (il @
= - )
@ PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
L'_; e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in

Il

Automation...

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

4. Click OK.
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BizInsight 5.0.35.2 Installing Additional Content Packs: Appendices

Excel 2007

1. Click on the Office button and then click on the Excel Options button.

]

Recent Documents

Hew
1 BizProperySheetdlsx W=l
% Open 4 Balance Sheet.xit
3 Balance Sheet.xls =l
4 SetGlobalProperties.xlsx =

zave

Save As ¥

Print k

Prepare #

& KPP AT

L
o
= |

[=3
-

Pyblish »

- g

Close

1) Excel Options [ X Exit Excel
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BizInsight 5.0.35.2

Installing Additional Content Packs: Appendices

Click on Add-ins in the left pane and then click on Go at the bottom on the

right pane.

Headers and Footers
Hidden Rows and Columns
Hidden Worksheets
Invisible Content
Microsoft Actions Pane 3
Solver Add-in

Document Related Add-ins

Disabled Application Add-ins

Ada.in: Bizinsight

S\Microsoft Office’\Officel 4.OFFRHD.DLL
E]\Micrasoft Office\Office14\OFFRHD.DLL
AT\Microsoft Office\OMiceld\OFFRHD.OLL
A&f'\Microsoft Office\Officel $\OFFRHD.DLL

e\ Officel 4 Libran\SOLVER\SOLVER.XLAM

Publisher: <Monex
[ Ho available
Location: C\Bizinsight\bin5'adxloader.dil

Deseription:  AddinModule

Document Inspector
Document Inspector
Document Inspector
Document Inspector
XML Expansion Pack
Excel Add-in

21
General "
4 s View and manage Microsoft Office Add-ins.
Formulas
Pracfing Aga-ins
Save Mame - [Locatian [Type [4]
Active Application Add-ins
Language Bizinsight CABizlnsight\binS\aculoader. dll COM Add-in
p— SizinsightXL Faundation CAWindowes\SysWOWE4\mscoree.dil Excel Add.in
o R Inactive Application Add
Analysis ToolPak JieeOMiceld\LibraryAnalysis ANALYSI2.XLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA (Officeld\Libranp\Analysis\ATPVBAEN.ILAM  Excel Add-in
Custom XML Data &l'\Microsoft Office\Officel 00OFFRHD.OLL  Document Inspector
Add-Ins Date (MU Jes\microsoft shared\Smort Tag\MOFLDLL  Action
Eura Currengy Toals A Office\Dfice1 #\Library EUROTOOLNLAM  Excel Add-in
Trust Center Finandial Symbal (ML) Jes\microsoft shared\Smart Tag\MOFLDLL  Action

Manage: [Excel Ad
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

3. In the Add-ins dialog, click on the Browse button.

faadms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

-r-u_.-o.-——
Automation... |

=
—BizInsight¥L .Foundation
ProgID: BizInsightXL.Foundation

4. Browse to the directory to which you installed Bizinsight and select the .xll
file in that directory. Then click OK.

x|
‘Q\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}
Organize *  MNew folder == o« (il @
= - )
@ PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
L'_; e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in

Il

Automation...

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

5. Click OK.
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BizInsight 5.0.35.2 Installing Additional Content Packs: Appendices

Excel 2003

1. Click on Tools > Add-Ins

B3 Microsoft Excel - Book2

23] File Edt View Insert Format | Tools | Data Window Hel
TRWER- NPV IR AV Rl ™’
B1 - 5~ a Research.,. Ak+Click
» | A =] c ‘j) Errar Checking,.. G
—{ |
o 5 I Speech k
-!- 3 | Shared Warkspace. ..
-E % Share Workbock. .
; | | Track Chaniges »
2 omipare and Merge Waorkbooks. .,
s a1
g T Protection k
10 Cpline Collsboration 3
| 11| Goal Seek...
E— Scenarios. ..
13
14 Formula Auditing ¥
15| l Macra 3
16
17 ety [
18| 3 AutoCorrect Options.. .
%‘ ngsFoniae...
M Qptions. ..
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Bizlnsight 5.0.35.2 Installing Additional Content Packs: Appendices

2. In the Add-ins dialog, click on the Browse button.

faadms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

-r-u_.-o.-——
Automation... |

=
—BizInsight¥L .Foundation
ProgID: BizInsightXL.Foundation

3. Browse to the directory to which you installed Bizlnsight and select the .xll
file in that directory. Then click OK.

x|
‘Q\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}
Organize *  MNew folder == o« (il @
= - )
@ PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
L'_; e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in

Il

Automation...

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

4. Click OK.
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Resolving “.xll could not be found” errors

In some rare instances, the name of the content add-in file provided with an update may
change. When an add-in file name is changed, Scan for Content will properly remove
that add-in file but will not delete the pointer to it that resides within Excel and the fol-
lowing error will occur:

Microsoft Office Excel @

‘cilusersYinda‘documents\BizContent'\BizMetERP. xl' could not be found. Check the spelling of the file name, and
verify that the file location is correct.

If you are trying to open the file from your list of most recently used files, make sure that the file has not been

renamed, moved, or deleted.

Perform the following steps to resolve the issue:

The remaining steps vary based on the Office version installed:

Office 2010/2013 steps
Excel 2007 steps
Excel 2003 steps

Excel 2010/2013

1. Click on File > Options.
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E- ri ) - - |
.i. Home Insert
= save

B save As

£ Open

jj Close
Info

Mew

Print

Save & Send

Help

| :] Options L; |
B Exit
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Installing Additional Content Packs: Appendices

Click on Add-ins in the left pane and then click on Go at the bottom on the

right pane.

Headers and Footers
Hidden Rows and Columns
Hidden Worksheets
Invisible Content
Microsoft Actions Pane 3
Solver Add-in

Document Related Add-ins

Disabled Application Add-ins

Ada.in: Bizinsight

S\Microsoft Office’\Officel 4.OFFRHD.DLL
E]\Micrasoft Office\Office14\OFFRHD.DLL
AT\Microsoft Office\OMiceld\OFFRHD.OLL
A&f'\Microsoft Office\Officel $\OFFRHD.DLL

e\ Officel 4 Libran\SOLVER\SOLVER.XLAM

Publisher: <Monex
[ Ho available
Location: C\Bizinsight\bin5'adxloader.dil

Deseription:  AddinModule

Document Inspector
Document Inspector
Document Inspector
Document Inspector
XML Expansion Pack
Excel Add-in

21
General "
4 s View and manage Microsoft Office Add-ins.
Formulas
Pracfing Aga-ins
Save Mame - [Locatian [Type [4]
Active Application Add-ins
Language Bizinsight CABizlnsight\binS\aculoader. dll COM Add-in
p— SizinsightXL Faundation CAWindowes\SysWOWE4\mscoree.dil Excel Add.in
o R Inactive Application Add
Analysis ToolPak JieeOMiceld\LibraryAnalysis ANALYSI2.XLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA (Officeld\Libranp\Analysis\ATPVBAEN.ILAM  Excel Add-in
Custom XML Data &l'\Microsoft Office\Officel 00OFFRHD.OLL  Document Inspector
Add-Ins Date (MU Jes\microsoft shared\Smort Tag\MOFLDLL  Action
Eura Currengy Toals A Office\Dfice1 #\Library EUROTOOLNLAM  Excel Add-in
Trust Center Finandial Symbal (ML) Jes\microsoft shared\Smart Tag\MOFLDLL  Action

Manage: [Excel Ad
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2. In the Add-ins dialog, click on the Browse button.

faadms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

-r-u_.-o.-——
Automation... |

=
—BizInsight¥L .Foundation
ProgID: BizInsightXL.Foundation

3. Browse to the directory to which you installed Bizlnsight and select the .xll
file in that directory. Then click OK.

x|
‘Q\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}
Organize *  MNew folder == o« (il @
= - )
@ PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
L'_; e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in

Il

Automation...

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

4. Click OK.
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Excel 2007

1. Click on the Office button and then click on the Excel Options button.

]

Recent Documents

Hew
1 BizProperySheetdlsx W=l
% Open 4 Balance Sheet.xit
3 Balance Sheet.xls =l
4 SetGlobalProperties.xlsx =

zave

Save As ¥

Print k

Prepare #

& KPP AT

L
o
= |

[=3
-

Pyblish »

- g

Close

1) Excel Options [ X Exit Excel
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Installing Additional Content Packs: Appendices

Click on Add-ins in the left pane and then click on Go at the bottom on the

right pane.

Headers and Footers
Hidden Rows and Columns
Hidden Worksheets
Invisible Content
Microsoft Actions Pane 3
Solver Add-in

Document Related Add-ins

Disabled Application Add-ins

Ada.in: Bizinsight

S\Microsoft Office’\Officel 4.OFFRHD.DLL
E]\Micrasoft Office\Office14\OFFRHD.DLL
AT\Microsoft Office\OMiceld\OFFRHD.OLL
A&f'\Microsoft Office\Officel $\OFFRHD.DLL

e\ Officel 4 Libran\SOLVER\SOLVER.XLAM

Publisher: <Monex
[ Ho available
Location: C\Bizinsight\bin5'adxloader.dil

Deseription:  AddinModule

Document Inspector
Document Inspector
Document Inspector
Document Inspector
XML Expansion Pack
Excel Add-in

21
General "
4 s View and manage Microsoft Office Add-ins.
Formulas
Pracfing Aga-ins
Save Mame - [Locatian [Type [4]
Active Application Add-ins
Language Bizinsight CABizlnsight\binS\aculoader. dll COM Add-in
p— SizinsightXL Faundation CAWindowes\SysWOWE4\mscoree.dil Excel Add.in
o R Inactive Application Add
Analysis ToolPak JieeOMiceld\LibraryAnalysis ANALYSI2.XLL  Excel Add-in
Quick Access Toolbar Analysis ToolPak - VBA (Officeld\Libranp\Analysis\ATPVBAEN.ILAM  Excel Add-in
Custom XML Data &l'\Microsoft Office\Officel 00OFFRHD.OLL  Document Inspector
Add-Ins Date (MU Jes\microsoft shared\Smort Tag\MOFLDLL  Action
Eura Currengy Toals A Office\Dfice1 #\Library EUROTOOLNLAM  Excel Add-in
Trust Center Finandial Symbal (ML) Jes\microsoft shared\Smart Tag\MOFLDLL  Action

Manage: [Excel Ad
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3. In the Add-ins dialog, click on the Browse button.

faadms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

-r-u_.-o.-——
Automation... |

=
—BizInsight¥L .Foundation
ProgID: BizInsightXL.Foundation

4. Browse to the directory to which you installed Bizinsight and select the .xll
file in that directory. Then click OK.

x|
‘Q\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}
Organize *  MNew folder == o« (il @
= - )
@ PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
L'_; e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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The Add-ins dialog should now look like the following:

add1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in

Il

Automation...

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

5. Click OK.
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Excel 2003

1. Click on Tools > Add-Ins

B3 Microsoft Excel - Book2

23] File Edt View Insert Format | Tools | Data Window Hel
TRWER- NPV IR AV Rl ™’
B1 - 5~ a Research.,. Ak+Click
» | A =] c ‘j) Errar Checking,.. G
—{ |
o 5 I Speech k
-!- 3 | Shared Warkspace. ..
-E % Share Workbock. .
; | | Track Chaniges »
2 omipare and Merge Waorkbooks. .,
s a1
g T Protection k
10 Cpline Collsboration 3
| 11| Goal Seek...
E— Scenarios. ..
13
14 Formula Auditing ¥
15| l Macra 3
16
17 ety [
18| 3 AutoCorrect Options.. .
%‘ ngsFoniae...
M Qptions. ..
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2. In the Add-ins dialog, click on the Browse button.

faadms 2
t Add-Ins available:
| Analysis ToolPak | oK |
s ™ Analysis ToolPak - VBA

|l BizInsightL. Foundation

™ Euro Currency Tools
™ Solver Add-in

-r-u_.-o.-——
Automation... |

=
—BizInsight¥L .Foundation
ProgID: BizInsightXL.Foundation

3. Browse to the directory to which you installed Bizlnsight and select the .xll
file in that directory. Then click OK.

x|
‘Q\ )v| . = Computer ~ Local Disk (C:) + Bizlnsight ~ - ml Search Bizlnsight 1O}
Organize *  MNew folder == o« (il @
= - )
@ PG50t Eiced 21 Mame | Date modified | Type
; bin 8/17/2013 11:50 AM File folder
i Favorites regs 8/17/2013 11:50 AM  File folder
Desktoy . o - =
B Desktop B BizNeteRP 2/2/2012 11:19AM  Microsoft Ex
4 Downloads 7
L'_; e e [#| Open a Support Issue 5/9/2013 12:32 AM Internet Sho
. Libraries
3 Documents
J'-‘ Music
[&5] Pictures
E Videos
M Computer o
£, Local Disk (C2)
= | 2
File name: | BizN<tERP ~| |add-Ins =l

Tools = 0K I Cancel |
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The Add-ins dialog should now look like the following:

add-1ns 2| |

Add-Ins available:

Analysis ToolPak =]
[ Analysis ToolPak - vBA

Tl BizInsightyL . Foundation Cancel
[ BizietERP
™ Euro Currency Tools Browse, ..

[ salver Add-in
Automation...

Il

[~

—BizInsightXL.Foundation
ProgID: BizInsight¥L.Foundation

4. Click OK.

9. Once in the add-ins dialog, uncheck the add-in mentioned in the error message.
You should get the following message. Click Yes. If you do not get this message,
you have unchecked the wrong add-in. Re-check it and uncheck the next one

that is shown that has a similar name.
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(Add-Ins e=)

Add-Ins avalable:

|| Anatysis ToolPak - oK

|| Analysis ToolPak - VBA

|w'] BizinsightXL. Foundation
|| Condrional Sum Wizard

e
|| Internet Assistant VBA Bra

oI
W ]
|| Sohver add-n
Microsoft Office Excel [=3e]
'ﬂ Cannot find add-n "C:\BizMet Software \BizInsighi off. Dedete from list?
[ ves | [ Mo

10. Close and reopen Excel to confirm that the error no longer occurs.
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